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SPM Quick Tip: Multi-Rename

Multi-Rename is located in the File pop down menu (File > Multi-

Rename). This will allow you to rename groups of images from the

cryptic number names given by the cameras (for example:

DSC000561) to more useful names such as Name001_L and

Name001_R. Even if there were holes in the original number

sequence due to deletions, the batch rename function will number

them 1 to the total number in the file, consecutively. This is very

useful. It will make it much easier to identify the two images that

form a stereo pair (if you are doing cha-cha or twin camera im-

ages), and is essential if you use the Multi-Conversion function in

StereoPhoto Maker, which can automatically batch process

countless stereo pairs. Here are the steps:

1. Select your files.

Once you've chosen

File->Multi-Rename,

a box comes up.

2. In the Look In box,

browse to the folder

where you stored

your original files.

3. Select Full Re-
name at the bottom.

4. Name the files.

Suppose there are

25 images you took at the 3D Weekend.

  *  In the box next to Full Rename replace the name with

      “3DWeekend” or with any meaningful notation you wish.

  *  In the numbering box start with "01", since you really only need

     two digits for 25 images.

  *   In the third box ,leave the ".JPG". Do this for both the left and

      right image folders if you have individual left and right images.

      In that case, the third box of the Left files should say “_l.jpg”

      and the right files will say “_r.jpg”.

Now it will be much easier to identify your files.    [    ][    ]
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SPM Quick Tips - How To
Straighten an Image

Knowing that SPM can fix many problems and improve your

stereo images is fine, but unless you have worked with it a lot, you

may not know how to do a particular fix. This season, we will have

a series of “Quick Tips” to demonstrate some image fixes.

For the first one, it is common to take a nice image in the heat of

photographing an event or scene, only to realize later that the

image is crooked.  Here is an example:

This image can be made more pleasing by rotating it.  To do that,

just open the image in SPM and go to the “Easy Adjustment” item

under the Adjust menu (or press the “K” key) and you will see this:

In the middle of the panel on the

left are these sliders:
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SPM Quick Tip: Correcting Distortion

Images taken with a wide-angle lens can suffer from distortion,

especially when the camera is pointed up, as in this image of a

building interior.  This can be easily corrected using SPM’s “Easy

Adjustment” and clicking on the “H_Pers.” tab.

Apply a grid so you can see some

vertical lines, then move the

sliders until both images appear

to be straight.  In this case, it took

about a 16.7 degree rotation.

Save the image under a new

name, so you do not overwrite

your original, in case you want to

re-do the change later.  Voila!

by Dennis Green
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Those rotation sliders are used most often to be able to align the

two images in a pair that have been taken with a single camera or

using the advanced 3D setting on a Fuji W3.  They allow you to

remove any unintentional rota-

tion between the two chips.  But

if you enter the same value in

both the L and R side, the

image is rotated as a whole:

Now just click the OK

button at the bottom of

the adjustment screen,

and the image pair is

automatically rotated

and cropped to get rid

of the black triangles

created when the

image was rotated -

and it does it to both

sides at the same

time!

Here is the new straightened image:

Always save your corrections with a new name so you can go

back and readjust the image if you decide that it needs more or

less rotation.  If you have any questions on this, send me an email

or see me at a club meeting. Dennis
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SPM Quick Tip - Resizing Images

Open StereoPhoto Maker (SPM) and go to File...MultiConversion.

Here are the settings you need.  Find the images you want to

format using the "Look in:" dropdown box.  Select the images you

want and check the following options:

1. Input file type - MPO files (from a Fuji camera) are Side-by-side.

Stereo pairs (from twin cameras or cha-cha shots) are "Indepen-

dent (L/R)".

2. Output file type - should be Side-by-side in JPG format.

3. Check the "Auto alignment", "Auto Crop after adjustment" and

"Resize"  boxes.  The resize width should be for one chip (e.g.

1400 Wide and 1050 High for our current competitions).

4. Do not check the “keep designated size” box.  SPM will ensure

that neither dimension exceeds the maximum you input.

5. Output Folder - click the Browse button to find the folder where

you want to save your formatted images. Do not save in the same

folder, as you may overwrite your original!

6. Click on the "Convert Selected Files" button.  SPM will do the

rest.
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SPM Quick Tips - How To
Check for Excess Deviation

What is “excess deviation” and why would you want to check for it

using StereoPhoto Maker?

As you may know, stereo images are made up of two nearly

identical pictures.  The difference between the two is that objects

that are farther away in the image are also farther apart than

objects in the front of the image.  This

difference is known as the stereoscopic

deviation.  In this anaglyph image the leaf

is the near point and the castle turret is in

the distance.

If your image has too much depth, the

deviation will be too large and it will be

uncomfortable to view.  The maximum

deviation should be around 3% or 1/30

of the width of the image.

Excess deviation occurs most often when taking close-ups or

macro shots.  If you are using a Fuji W3 or a pair of cameras with

the lenses about 75mm apart (same as the W3), you will probably

have too much depth if your nearest object is less than 7 feet from

the camera (assuming you have other objects in the image that

are more than 25 feet away).

It is natural to want to fill the frame with your subject, so if you have

taken a picture of a flower or other small item, you should check to

see if the deviation will be too great to view in projection.  Even if it

looks OK on a monitor, when it is projected (for our competitions),

it is being magnified and may have too much depth.

SPM has a couple of easy ways to check the deviation when you

are deciding which images to enter into a competition or have

projected for the members in our Open Projector slot.
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One thing to be aware of is the relationship between the size of your

text zone and the size of the font.  If the text zone is too small, you

may find the bottoms of your descending characters are being

clipped off, which you may not notice at first.  Having to redo a

whole set of titles due to this effect is not ideal.

The good thing is that once you find a font and text zone that works,

SPM will remember that, even if you close the program or use it for

other actions in between sessions of adding text.

Clicking the “Enlarge this dialog for next time” box will make the

preview image larger and will also make the dialog box fill your

screen to make it easy to see the final effect.

Try adding some text to your next project!
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First, open your image with SPM and view it in anaglyph (or

interlaced) mode.  Go to the “View” menu and at the bottom you

will see a selection for

“Grid Settings...”.  Select

that and click on “Show

Grid” with 29 as the

number of vertical lines.

This will divide your

image into 30 sections.

The distance between

any two adjacent lines is

1/30 of the total width,

which is what your maximum deviation should be.  You can see in

this image of a tide pool that the triangular object (circled) is more

that twice the desired distance apart.  This deviation will cause

eye strain, especially when projected.

If you want to know what your percentage value is, just tap the left

arrow key until the left and right far point objects coincide. Then

read the “X” value at the

bottom of the screen.  In

this case it is “99”.  Di-

vide that by the total

image width, which is

also shown at the bottom

- in this case “1491”.

This picture’s percentage

is about 6.6%, again

slightly more that twice

the recommended value.

Use this quick tip to

check your images before showing them to others or submitting

them to a competition.  If the image can’t be fixed (possibly by

realigning and cropping), it might be better to choose another

image to share.  At least you will be aware of a possible problem.
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SPM Quick Tip - Adding Text
There are many reasons why one might want to add text to a stereo

image.  The most common is to add a caption to be able to identify

the content - a location or people, or the significance of what the

viewer is seeing.  Before StereoPhoto Maker, captions in stereo

took a lot more effort using programs like Photoshop or Elements,

but now with a few mouse clicks, you can add text to your images.

To do so, open your image in SPM

and select “Add Text” from the Edit

menu (or use the shortcut [Ctrl - T].

You will get a dialog box that includes

these controls on the left side:

The top section determines where the

text will be placed, first setting one of

six general locations, then moving the

spot on any axis (positive values in

the “Depth” box bring the text forward

in front of the image).

The second section allows you to

create a text zone with colored back-

ground, either above or below the

image or overlaying it (which can be

done with or without the text zone.  If

placed at the top or bottom, this zone

will be added to your image height, so if you need a specific height

(as with many exhibitions), you will need to reduce your image

height by that amount or resize after adding the text zone.

The last section allows you to specify a font, including the size and

style, and add a shadow if you like.  It also has the box where you

input the text you want.  You will be able to see the text in a preview

pane to the right of this box, which will give you an idea of what it

will look like when you click the OK button.  You can try out different

fonts and sizes, as well as seeing whether the amount of text in your

caption is too much to fit the image width.  Only one line of text can

be added - extra characters do not wrap to a second line.
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SPM Quick Tips - 3 Notes on
Saving Stereo Images
by Dennis Green

1. Shortcut: When editing images in StereoPhoto Maker,

whether to align or crop an image, or just to set the stereo window,

you need to save the adjusted image.  While most Windows

programs use the keyboard shortcut “Ctrl + S” to save, that short-

cut in SPM is to “Save Left/Right Images...” which will give you two

individual images instead of the combined image.  A simple save

is done by just pressing the “S” key.

2. Format: If you have a 3D monitor, laptop or TV that you use to

view images while you are editing, or if you edit in anaglyph mode

on a 2D monitor, you may forget to go back and change to the

side-by-side view before saving and find you end up with another

format, like interlaced or anaglyph.  At the bottom of the “Save”

dialog box there is a checkbox that allows you to save in SBS

format even when you are viewing in interlaced or anaglyph.  This

can save a lot of frustration when working on images.
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Check the “Two-stage cropping” and “Resize to above after crop-

ping” boxes, click OK and when you press a number key, SPM will

be in crop mode for that size.  Just drag across the image to get the

desired height, then you can reposition the crop box to keep the

image area you want.

If you do not crop the image to your display aspect ratio, the image

will be shown with black bars on the sides or on the top and bottom

(depending on which type of mis-match you have).

Your images always look better when the subject fills the frame, and

in a similar way, your images should ideally fill the display for the

greatest effect.  Try cropping some images to fit your display and

see if you prefer the results!      [    ][    ]

4:3 image on a 16:9 screen

16:9 image on a 4:3 screen

Example of a 4:3 crop box on a 1:1 image
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SPM Quick Tip: Crop to an Aspect Ratio
 by Dennis Green

The aspect ratio of an image indicates the relationship between its

width and height given in a proportion, such as 4:3.  The three most

common aspect ratios for stereo photography are 4:3, 16:9 and

1:1, although you can crop an image to any ratio you prefer.

The historical “standard” of 4:3 was established by William Dickson

and Thomas Edison in 1892 when they settled on their movie film

height of 4 perforations, which resulted in the 4:3 ratio when applied

to the available film area of a 35mm strip.  16:9 is the standard for

HD TVs and monitors, as well as for widescreen video supported

by the DVD standard.  1:1 ratio was the standard for medium

format cameras. It is the format of choice for mobile apps like

Instagram, and is supported by Facebook and Twitter.  It is also the

best for displaying Left/Right stereo pairs on a phone display for

viewing in a stereo viewer like View-Vaster or Google Cardboard

or for creating standard Holmes-style stereo cards.

Most digital cameras, including the Fuji W3, allow the user to

choose a default aspect ratio of either 4:3 or 16:9, a choice that will

probably be made based on how you want to display your images.

If you have a 3D TV or monitor, the 16:9 ratio may be a good

choice, although it does not take advantage of the full area of the

camera sensor.

If you have 4:3 images that you would like to reformat to fill the

screen of a TV, or if you have 16:9 images that you would like to

project with 4:3 projectors (as the DSS has done to date), you can

use the crop tool in StereoPhoto Maker to do so.

The SPM Crop Tool has several fixed

crop options that can be set by going

to Edit -> Preferences and selecting

the Crop tab.  If you put in your most

used sizes (like 1400 x 1050 for our

club competitions), you can just hit the

number (2 in this example) to get the

crop tool for that size (or 3 for 16:9).
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3. Image Quality: This setting can be adjusted to reduce the size

of the new image file.  But how much can you reduce it before you

would see visible deterioration of the image?

Jay Horowitz of the Ohio club sent a link to a website that shows

the effects on actual images of different compression values.

http://regex.info/blog/lightroom-goodies/jpeg-quality

He gave these tips with the link:

“I strongly suggest everyone take a look at it. It shows a variety of

good test images and how the 'quality’ setting affects them. For

each image, there is a close up of the most-affected area and

tabs below for different quality settings. You move your mouse

over the tabs and see (or not see) the difference, and also check

the red bar on the left which shows the resulting file size. Just

moving between the first two tabs (loss-less versus Quality=10

out of 100) shows how decent the compression looks even

though the file size is less than 1 tenth the original!

“But one word of caution. Repeated editing of jpegs and saving

at lower quality will quickly degrade your image. So save your

original at the highest resolution and quality, and only re-size

and save at lower quality for e-mailing or uploading to websites.”

Here are the file sizes as shown in SPM for settings at the highest

setting (99) and at a moderate (80) setting:

Note that the image size (right) stays the same, but the file size

drops from 7.2 MB to 2.5 MB - almost 1/3 the size!  Check out

that website and experiment with your own images! [    ][    ]
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SPM Quick Tips - Clone Out a
Finger Blocking Part of an Image

Due to the way the Fuji W1 and W3 were designed, one of the most

common issues with images is having a finger blocking part of one

image like this:

Since most of the blocked portion of the image is in the back-

ground, the SPM Clone Tool can be used to repair this quickly.

1. Put image to be changed on the right and hit “K” to go into Easy

Adjustment. Enlarge to 100% and superimpose the area around

where the cloning will happen (to clone at the same depth).

2. Return to side-by-side view, place cursor where you want to start

cloning, hold SHIFT and LEFT CLICK and hold.

3. Drag the clone cursor over the area to be cloned

4. Save the image - that’s it! For more details, go to stereo.jpn.org/

eng/stphmkr/SPM Clone Tool Instructions PDF_Starkman.pdf

Images from www.lhup.edu/~dsimanek/3d/stereo/tricks.htm
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SPM Quick Tips - Mirror View
Method for Stereo Images
by Dennis Green

One way to view your stereo images if you cannot freeview and

do not have a 3D monitor is to view them with a regular (2D)

monitor using a mirror and this arrangement:

Display your image in SPM
using side-by-side mode and

press the 'E' key to set the

image spacing to wide. The

key toggles through narrow,

medium and wide spacing.

This example has the left-

image mirrored.

To do this, press Shift+F9.

Place a mirror about 5"x5"

square against your nose

and view the right image

with your right eye.  Focus

your left eye on the right image but carefully adjust the angle of the

mirror until the reflected left-image merges with the right one.

You may wish to share your stereo images with others using this

method by batch-converting them to SBS (mirror-left) format.


